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Preface

This manual is a reference guide for the Lithography Menu, providing information for
every feature included. The first chapter contains some general information related to the
setup of the menu. The following chapters are sorted by menus, and sections are defined
by the functions in those menus, including functions that depend on system configuration
options. Each function is described in its functionality as well as in the context of possible
applications.

Step-by-step instructions on how to use the common functions of the Lithography Menu
in the context of standard system operation are given in User Guide I: System
Operation.

In the appendix, a menu revision history with information on later additions and bugfixes
can be found.

Precautions and Safety, Terminology

The DWL 66Fs uses lasers and high voltage electronics. It is therefore vital that the
operators and all other persons who are allowed access to the system have been informed
about the safety risks stated in this manual and User Guide Part I: System Operation.

No untrained person, or person not familiar with the contents of all related safety
sections may be allowed to operate the system or work in its close environment. If
instructions are not followed carefully, danger to personal health and damaging the
equipment is at risk.

CONVENTIONS USED

Throughout this manual there are safety warnings.

To classify the degree of danger in each of these situations, this guide uses the
conventions defined in ANSI Z535.6-2011:

m Fatal or severe injuries can occur if instructions are not
followed.

A WARNING! (Severe) injuries can occur if instructions are not followed.
A CAUTION! Mild injuries are possible if instructions are not followed.
NOTICE: Denotes advice to avoid machine damage, as well as hints for
: a more effective use of the machine.

For more details on safety risks refer to User Guide I: System Operation.
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Additional terminology conventions used in this manual are:

Note: Gives advice or hints to help the user to find the best solutions for the task at
hand

Also, in some parts of this user manual, general information is given including special
symbols that are used as wildcards. These wildcards stand for entries that change with
each specific instance of application. The wildcards used in this manual are:

<....>- text between angular brackets denotes which information is expected here. The
brackets are part of the wildcard and don't occur in the final text.

Related Documentation

Heidelberg Instruments offers several further manuals related to the machine and its
operation. If you did not get one of these or need an update, please contact Heidelberg
Instruments, Germany.

Pre-Installation Guide System requirements, sizes and weights of
components etc.

Safety Guide Describes risks and safety measures during
installation and service periods

Conversion Software Manual Manual for the HIMT conversion software used
for data preparation and fractioning

User Guide, Part | Step by step instructions for general system
usage and standard applications
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Contact

Should you need assistance, please call Heidelberg Instruments during normal business
hours (CET)

Phone: +49-6221-3430-0
Fax: +49-6221-3430-30

or contact your local service office:

China: Japan:

Heidelberg Instruments China Heidelberg Instruments Japan
Rm.101, Block 1, Animation Park, Germany Center for Industry & Trade
Yuehai Street, Nanhai Road, 1-18-2, Hakusan

Nanshan Distr., Shenzhen 518045 Midori-ku, Yokohama, 226-0006
China Japan

Phone: +86-755-8301599-1/-2 /-7 Phone +81-45-938-5250

Fax:  +86-755-8301599-4 Fax +81-45-938-5251
email: service_china@himt.de email: service_japan@himt.de
Taiwan: USA:

Heidelberg Instruments Taiwan Heidelberg Instruments Inc. USA
5F,No. 174 Chung Yang Road, 2807 Oregon Court, Unit E2
Hsinchu City Torrance, CA, 90503

Taiwan USA

Phone: +886-35311-304/-284 Phone: +1-310-212-5071

Fax:  +886-35311-243 Fax:  +1-310-212-5254

email: service_taiwan@himt.de email: service_usa@himt.de
Korea:

Heidelberg Instruments Korea
#316 Expo Officetel, 381
Mannyeon-dong, Seo-gu
Deajeon 302-834

South Korea

Phone: +82-42-482-1668
Fax: +82-42-482-1669
email: service_korea@himt.de

You can also reach Heidelberg Instruments via e-mail: himt@himt.de, or visit our site on
the Internet: http://www.himt.de
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Chapter 1: Startup and General

The Lithography Menu usually comes with pre-configured standard users that are
equipped with certain typical permissions for the tasks they have to perform. The typical
functionalities have been arranged in an intuitive way to help operating the machine
without having to continuously open and close windows or panels.

For new users, default setups exist that match the typical tasks of the related user level.
These can be adjusted in any useful way to adapt the menu to the daily operations of this
user. As these setups are different for each user level, for the tutorial, we start with an
empty menu.

Tutorial: Basic Setup

The fresh interface consists of the menu bar, two anchored containers and a floating
container. At the bottom, a status bar shows the name and user level of the currently
logged in person on the left, and some status information on the machine on the right.

File Wizardry Controls Jools Window Help
anchored
‘container 2

| floating
container

anchored
container 1

status bar -

=/, John Doe (CustomOperator) WilteHead . 2=0 Pneumatic Laser OFF Interferameter <Ready>

The LiveWindow shows all messages from the program. It depends on the menu settings
if it stays open after startup.

For the moment, the floating container should be either moved to the other window by
drag-and-drop, or closed. To close the container, click on the cross button in the upper
right corner and select Close floating window. It can be opened again anytime from the
menu Tools by selecting Floating window.

Maximize the main window of the Lithography Menu.

Reference Manual 5
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The size of the anchored containers can be changed by grabbing the dividor by right-click
on it and moving it while the mouse button is held down:

File Wizardry Controls Jools Window Help

=/, John Doe (CustomOperator) WriteHead . z=0 Pneumatic Loser OFF Interferameter <Ready>

Lime ¢ 1
file Wizardry Controls Tools Window Help

3. release
mouse button

HEIDELBERG
— INSTRUMENTS

2 Jahn Doe (CustomOperator) WriteHead — z=0 Pneumatic Laser OFF Interferometer <Readys

-

The containers are used to deposit frequently used windows (control panels, wizards, log
windows) in them, so that whenever the user logs in again these are automatically started
in the same configuration they were last in.

As an example, we open the Designs panel (Menu Controls - Designs). The panel
opens in a random position and floats freely. We can either leave it like that and keep
pushing it around whenever it is in the way, or dock it into one of the containers.

User Guide Part Il
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When grabbing the panel with the mouse, as soon as we start moving it around, a
representation of possible docking positions within the container appears:

File Wizardry Controls Tools Window Help

Hal

=
Muterschif_475 | Mutierschifl 506 | DWLSystemController

-2 General

update ‘ﬁ |‘£‘ Properties
ready

HEIDELBERG

iNSTRUMENTS

3 John Doe (CustomOperator) Wiiteread ¥ 2= 0 Preumatic Loser OFF Inierferomeier <Ready

Each arrow stands for one of the borders of the container, while the center button arranges
the panel as a new register card behind the panel(s) that is/are currently docked into this
container.

Keep holding down the mouse button and move the mouse cursor onto the icon for the
position in which the panel should be docked:

i ume o2 suia 4563 1757401507 1253506 A - corerea v o T

file Wizardry Controls Jools Window Help

HEIDELBERG

lNSTRUMENT S

/! John Doe (CustomOperator) Witteread ¥ 2= 0 Preumatic Loser OFF Interfer <Ready>

Now release the button.
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As only one window is open yet, it makes no difference which arrow was chosen; the panel
will fill the complete container. Only if the register card was chosen a difference can be
seen: Instead of the usual window top bar, the panel gets a register tab with the cross
button for closing.

To see the effects of arrangement within the container, open a second window. The only
other window available even in the most basic setting is the Memos window (Tools ->
Memos). Again, it appears first as a floating window:

T HEIDELBERG

ready ~— INSTRUMENTS

;'4 John Doe (CustomOperator) WriteHead ¥ 2 =0 Pneumatic Laser OFF Interferome <Ready>

Drag-and-drop it like the previous one to one of the border arrows, e.g. the right one. The
previous window will automatically be resized to make room for this second window that is
now docked into the container:
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file Wizardry Controls Tools Window Help

=
Muterschifl 475 | Mutisrschif_506 | DWLSystemController |
® General

HEIDELBERG
iNSTRUMENTS

update ‘ B “‘L‘ Properties
ready
WriteHead . z=0 Pneumatic Loser OFF Interlerameter <Ready»

ready
/! John Doe (CustomOperaton

Each window can be made to float again by grabbing it at the top bar and dragging it
away. Remove the Memo window from the container in this way and dock it in again as

register card, using the center icon of the docking cross:

file Wizardry Controls Jools Window Help

LT ]

:_‘!' Save

HEIDELBERG
iNSTRUMENTS

rteread T 2=0 Pneumatic Laser OFF Interlerameter <Ready»

ready

/! John Doe (CustomOperaton

Now, each window fills the container completely, and the tabs can be used to swap
between the windows. Grabbing the tab and pulling it away again removes the window
from the container and returns it to floating state. Dock it into the second container for

practice:

Reference Manual



HEIDELBERG DWL 66"

iINSTRUMENTS

file Wizardry Controls Jools Window Help

HI Lime 0.9 Build 4583.17374(19.07.12 9:3%:08 AM) >> i & X
x)

Designs_ €3 Memas

T HEIDELBERG

iINSTRUMENTS

¥ 2-0 Pneumatic OFF

Note that the remaining window is still a register card, even though it is the only one left in
this container.

Floating windows may slip behind the main window if something is selected there. In such
a case, the window can be brought back to the front using the Window menu. Try that by
removing the Memo window from the second docking container again and clicking
anywhere in the main window afterwards. The floating window slips behind. Bring it to the
front again.

Floating windows can be positioned outside the main window of the Lithography Menu.
However, floating windows generally are not restored when the menu is restarted. If a
window should generally be positioned outside the main window, or should stay floating,
but still be restored at startup, it has to be docked into the Floating Container.

The Floating Container opens at first menu start. If it was closed after that, it can be re-
opened at any time from the Tools menu by just selecting Floating Window. Dock the
floating window into the Floating Container, and position that wherever you want it. Now,
this window is available even after a restart of the menu. Also, the Floating Container
always stays on top of the Lithography Menu.

Undock and close the windows used for testing and start creating your own setup
according to the available functions and what you require regularly in the current login.

Recommended Setup
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After installation, the system is usually transferred with the following setup of panels, or a
very similar one:

i L 10 Buia 694283381 L/2012 35116 PM) > connecaed fo DWLES - N ST
Fis  Cortroh  Wosrky Took  Devicm  Window  Help
e maoe ) o - -
“f oo =] Eynsrrloerd B Lugn B
s Qe @ oo BE- oo [Fomer v e - o e - B A
:‘m | i : - g DL
index g 5 L o ¥
e o= ] n-ml' Eﬁ-u !;"\\ R :“-“ :":\ml
o : - = =TT
il : il | = 2 2
e x . = T oo |t i e
- VA e ey
.:g i o ] s s
= — =
0 =[] [0 an
A5 g Poserlevel L]
A5 Vezeuredpovs D]
::5 Fous-Oet L
' $ % E =
s ' '
-5
A5
-5
A5
it
-5
—
n PE— ++50
: : Bl —kikie ot e
G =z |
i = : HEIDELBERG
=5 INSTRUMENTS
HIMT Sarvice [Adminintetor) ! 2= Pnmmats Lame OFF. Inksciuravstas ‘{Remchf o
e Left container: Job control panel and global alignment wizard, tabbed

¢ Right container:  System control panel
¢ Floating container: Camera control panel (positioned on HIVision monitor)
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User Permissions Management

The Lithography Menu offers five user groups in a hierarchic structure:
1. Administrator (all permissions available from start)

2. HIMT engineer

3. Custom administrator

4. Custom engineer

5. Custom operator

It also offers a host of permissions that determine which functions are visible for a certain
user, or what he can modify. Permissions are sorted into groups that can be assigned to
each user according to the needs of his work.

To access the user database in the Manage user database panel, open Tools > User
manager.

In the top level, there is an alphabetical list of all users whose settings can be modified by
the current user, plus the current user himself. After each login name, the user group to
which the corresponding user belongs is written in brackets. Clicking on the plus (+) sign
close to a user name shows the permissions this user has been granted so far. The right
half of the window contains a list of all available permissions, sorted in categories. The
permissions granted to the currently selected user have a tagged checkbox.

User management permissi_qn should be granted rarely, as it can
strongly influence the versatility of the system for the users! Only few
administrators should have this permission.

MANAGING USERS

Users can be added or deleted using the controls of the User toolstrip.

e Adding users:

1. Click on the plus (+) sign. A dialog window opens

2. Enter name and password of the new user

3. From the drop-down list, select the user group that the user should belong to
e Deleting users:

1. Highlight the user to be deleted

2. Click on the plus (-) sign

3. Confirm

In addition, there is a control Change password in the User toolstrip. It allows to change
the passwort of any of the listed users to a new password specified by the administrator.

12 User Guide Part Il
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ADAPTING USER PERMISSIONS
For user permissions management, the following rules apply:

e Each user can only create users belonging to his own group or a group below that.

¢ Inthe same way, users can only modify the permissions of other users in the same or a
lower group.

e Each user can only hand on permissions he himself posesses.

e Users can not change their own permissions.

Only administrators have all available permissions from the start. Which of these are
handed down to users of other groups is defined by the administrators during creation of
the new users.

Only names of users whose permissions can be modified appear in the list of users. The
own name appears in red, as no user can modify his own permissions.

Permissions can be granted or withdrawn by marking a user and then ticking/unticking the
checkboxes in the list on the right. Also, permissions can be withdrawn by opening the
permission list of a user (plus (+) sign beside the name), highlighting the permission and
clicking on the minus (-) button in the Permissions toolstrip.

For a list of all available user permissions groups and their effects see the table below. In
the following sections, each feature of the Lithography Menu is marked with the user
permissions group required to use it.

User User Permission Menu Item(s) Other Item(s)
Permission Group
Item
None required None required File>* Floating container
Wizardry Help functions
Tools>Floating window DebuglLevelEditor
Tools->Change password
Tools>DebugLevelEditor
Window
Help>~*
Category Menu
Control.Access. | AllControls Controls>* all control panels,
overrides single selection
AllWizards Wizardry->* all wizards, overrides
single selection
Menu. AccessAllDevices Device>* all device control panels
ChangelLanguage Tools>Language—>*
AccessLogService Tools>LogService>* LiveWindow
AccessFireFips Tools>FireFips>* Edit FireFips
configuration panel
Show communication
window
Menu. AccessConfiguration Tools->Configuration>Menu Edit menu configuration
panel

Reference Manual
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User User Permission Menu ltem(s) Other Item(s)
Permission Group
ltem

Device. Initialize Devices>* All device windows:
Initialize device

AccessSpecificArea Devices>* All device windows with
specific data sets
available:
Update view - Set up
view

AccessDummyMode Devices>* All device windows:
Activate/Deactivate
dummy mode

AccessConfiguration Devices>* All device windows:
Edit configuration

AccesslLog Devices>* All device windows:
Show/hide log viewer
Save log

Writemode. Change Main Menu:
Write mode selection
control

Modify Main Menu:

Create write mode
control

Delete write mode
control

Edit write mode control

Database. Administration Tools>User manager Manage user database
window
Permissions list filled
with own permissions

Job. Modify Job control panel:
Activate die
Deactivate die
Columns

Create series

Fit map control to
container

Clear designs
Templates list
Editing register card

ModifyTemplates Job control panel:
Create template
Remove template

Category Wizards

Wizard.Access | BeamOffsetCalibration | Wizardry>Writehead—> Beam offset calibration
Wizard Calibrate beam offset wizard
CameraOffsetCali- Wizardry->Camera->Set Camera offset wizard
brationWizard camera offset

14 User Guide Part Il
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User User Permission Menu ltem(s) Other Item(s)
Permission Group

ltem

Wizard.Access | BacksideCameraOff- Wizardry->Camera->Set Camera offset wizard

setCalibrationWizard

camera offset

CameraCalibration

Wizardry->Camera->Calibrate

Camera calibration

Wizard camera wizard
GlobalAlignment Wizardry-> Alignment->Gilobal Global alignment wizard
Wizard alignment

AlignmentScript
CreationWizard

Wizardry-> Alignment->Create
alignment script

Alignment script creation
wizard

ExposureltemWizard

Wizardry->Job
management->Create/execute
exposure job

Job creation/execution
wizard

Category Controls

Control.Access.

DesignsWizard Controls>Designs Designs list panel
Measurement Controls>MeasurementRecipes | Measurement recipe
RecipesWizard setup panel

Measurements Wizard

Controls=>Measurements

Measurement algorithm
creation panel

MemoWizard Controls>Memo Memo editor
ScriptWizard Controls—>Scripts Script creation panel
TemplateWizard Controls>Templates Video template creation

panel

ProcessWizard

Controls=>Job

Job control panel:
Control
Execute
Stop
Job list
Execution status
register card

SystemControl Wizard

Controls-> System control

System control panel

Category Devices

Device.Access. | <device name>

Devices—><device name>

Device window of
<device name>,
available controls
depend on general
settings

Cameras

Devices—>
Camera Selector>Camera

Camera control panel

Reference Manual
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J,—' — Change password il —

Menu.Changelanguage
Job.Modify

Job Modify Templates
WriteMode.Change
MenuAccessLogService
Menu.AccessConfiguration
Wizard. Access. AllWizards
Wizard.Access.CameraControl
Menu.AccessFireFips
Wizard.Access.TemplateControl
Wizard.Access.JobControl

Wizard.Access.SystemControl

7 e i : Menu -
=} John Smith CE (CustomEngineer) ~
) [] controls Access AliControls

[] controls Access AllWizards
[7] MenuAccessAllDevices
Menu.Changelanguage
Menu.AccessLogService
Menu.AccessFireFips
Menu.AccessConfiguration
|:| Device Initialize

|:| Device AccessSpecifichArea
[] Device AccessDummyMode
[] Device AccessConfiguration
|:| Device AccessLog
WriteMode.Change

[] writeMode Modify
Database Administration
[] system Modify

Job Madify

Job Maodify Templates

Wizards

11

Database.Administration

[] Wizard Access BeamOffsetCalibrationWizard
[] Wizard Access.CameraCalibrationWizard

[7] Wizard Access. GlobalAlignmentWizard

|:| Wizard Access AlignmentScriptCreationWizard
[] Wizard Access ExposureltemWizard

WriteMode Modifiy

- = Jane Miller (CustomOperator)

Figure 1: User database

General Functions

The Lithography Menu mainly consists of wizards that lead through certain typical
procedures step by step, and panels, that group together controls related to a certain task.
Apart from the specific functions of each wizard or panel, there are some functions that are
common to all menu components of one type. These, and the menus from which all
functions can be accessed, are explained here.

Also, there are certain features that appear in several contexts. How these are used is also
part of this section.

WIZARDS

Step numbers:In each sequential wizard, numbers on the left represent the steps of the
sequence. Steps that may be selected are colored, inactive steps appear
in greyscale. The current step is marked by a frame.

At
Select focus mode

Usually, a step gets activated once the previous step has been finished.
@ However, sometimes steps are skipped and stay inactive because of a

selection that was done, or several steps are activated at the same time,
so steps can be omitted by the user. This can speed up the sequence if
default values are to be used.

e Also, by clicking on the number of a step, it is possible to return to that
point and check on or change the selection done there.

QuickMode: At the bottom of each wizard, the Quick Mode can be turned on or off with

2 a button showing the icon of a green running man.

16 User Guide Part Il
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FieldAlignment

GlobalAlignment

© © 9@ © @ @ @

elect type of alignment...

Figure 2: A wizard panel with description window open and pinned
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Description:

Edit settings

Restart

When in Quick Mode, whenever there is a step that consists only of a
selection between options, the wizard automatically jumps to the next step
as soon as this selection is done.

The Description control opens a text field with a description of the task at
hand in the current step.

If the text field is opened by just hovering with the mouse pointer over the
control, it closes again immediately when the mouse pointer is moved
outside the area of control and text field. The title bar of the field is light
grey in this mode.

If the field is opened by clicking on the control, it stays open until the user
has clicked into some other region of the menu window. The title bar of the
field is dark grey in this mode.

A pin is visible at the right end of the title bar in both cases. A click on this
pin fixes the text field so that it stays open even if the mouse is moved out
of the area / a mouse click occurs outside the area. All controls that were
previously covered by the field are shifted above it, and its height can be
changed by click-and-drag on the border. In this way, the description can
be kept open through all steps.

The pin is removed by another click, returning the text field to the previous
property.

A toolbox icon button at the bottom of each wizard opens the Edit wizard
settings window for that wizard. Here, the user can select if the
descriptions for each step should be shown in a pinned window at the
bottom of the wizard per default, or not. The description windo can always
be opened and pinned manually.

With the double arrow button at the bottom, the wizard is restarted.
Previous values are kept in the edit boxes for reuse. This function is
important if a wizard is docked in and kept open continuously. If a wizard
is closed after each use, it is automatically restarted at the next call.

Navigation arrows

At the bottom of each wizard, there are arrows for navigation. These can
be used to navigate between active steps. Which steps are active can be
seen from the number list (see above). The first button serves to directly
jump back to the first step, the others move just one active step back or
forward.

18
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PANELS

toolstrips:

hAo

Series - Matrix

FullView |_|:»

Show options:

"
|

MAIN MENU

Toolstrips contain controls that are either marked by icon buttons, or by
text. Depending on the orientation, each toolstrip has a name written in
orange at either the left (horizontal) or the top (vertical).

Toolstrips can be moved along the panel borders by drag-and-drop if
grabbed at the dotted line at the left/top end. The toolstrip changes
orientation automatically to align to the closest border. All other controls
shift to make room for toolstrips along a border once one toolstrip is
positioned there.

If a toolstrip is too long for a certain position, the controls that do not fit into
the available space are hidden and can be accessed via a small arrow at
the toolstrip end.

In the Main toolstrip, a toolbox icon button offers acces to general settings
of a panel. In the left half of the settings window, general settings like
colors or units can be adapted for that panel. The right half contains the
toolstrip manager. As adaption of the toolstrips will usually only take place
in the System control panel (Controls > System), this feature is
explained there.

The Main menu of the Lithography Menu is the starting point of all operations. From
here, wizards and control panels can be opened, and certain functions can be started. It is
the only menu in the graphical user interface, as all panels use toolstrips to sort functions.

Metrology
Exposure
Memo
Scripts

Job
SystemControl

Controls | Wizardry T Features of the menu:

* | e entries with arrows open submenus with further options
3

e plain entries can either be direct controls, or they open panels or
wizards

e checkmarks in blue fields mean that either the wizard/panel
related to the entry is already open, or the option/function that can

LISTS

be selected/started is already active.

Among other items, panels and wizards may contain folder lists or grids with parameters.

To help to get a

quick overview, all contents are not always visible at once.
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e Working with folder lists:

Folders can only be opened or closed by clicking on the plus
(+) or minus (-) signs attached to them. In some places, clicks
on folders open properties windows for the whole folder and all
its contents.

An orange warning triangle means that an item is missing data.

A cross to the left of an icon means that the item is selected.

“ testpatem4mm A right-click on browser items opens a context menu with
' functions related to this item.

\ test pattern 10mm

[ During execution of an item, a double-arrow appears next to it.

. Extending / collapsing parameter lists:

Propertes " Main groups are usually extended by default. Subgroups that
- . can also be displayed as one parameter are collapsed. Control
E.”"“ over extended or collapsed view is given by the small
True triangles:
1 =
00725400y 4 filled triangle: parameters below up to the next heading
SO v belong to a group that may be collapsed to have a better
overview.
¢ Indeces X=1.Y=1
Location Center
C e — * empty triangle: a sub-group of parameters exists and may

S ~  be accessed by clicking on the triangle.
e Changing parameters in parameter lists:

Generally, all parameter lists are tables with the parameter or parameter group names in
the left column and an editable field in the right column at each parameter. Some fields
can be edited directly (text fields), for some, only certain options are available that are
offered in a drop down list, or a separate window is required to make a selection.

1 For direct editing, just click into the field. A cursor appears, and the
contents can be edited.

on [=] If a drop down list exists, the click makes an arrow appear. Click on the
arrow to open the list. Click on a list item to select it. It is transferred to the
text field, and the list closes.

(mone)-) |If a separate window is required for the selection (e.g., for selection of a
file), a button with three points appears at the right side of the text field. This
button opens the required window. As soon as that window is closed again,
the result of the operation(s) done there is transferred to the text field.
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Chapter 2: File, Window, Help

These three menus contain the most general functions of the Lithography Menu.

¢ File
Close — closes the Lithography Menu, ending all currently running tasks. All
settings except those of floating windows are saved so that at the next
menu start, the interface looks the same as before.
e Window

Lists all windows and panels that are currently open. Clicking on an entry in this list
brings the related window or panel to the foreground.

Note: The HIVision window is not part of the Lithography Menu and therefore not
listed here. See above for more information on HIVision.

e Help (Note: no content available as of V 1.0, please check Revision history for
changes)

Content — gives access to a table of contents of the available online documentation

Index — gives access to a list of indexed keywords provided in the online
documentation

Search — opens a search panel to search for a certain keyword or phrase within the
online documentation contents

About — opens a window with Lithography Menu version information
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Chapter 3: Controls

In the Controls menu, all control panels are collected that support the operator in certain
tasks like the manual setup and execution of jobs, the definition of camera templates or
the direct control of hardware components.

Functions require user permissions of the Control.Access.<group name> category, or user
permission group Control. Access.AllControls.

Metrology — This is a group of controls that all relate to measurements.

Measurement recipes — panel for creation and administration of
measurement sequences based on a camera image

Requires user permission group MeaurementRecipeWizard

Measurements — gives direct access to the optical measurement
methods available in the sequences as well as
mechanical methods, for single measurements

Requires user permission group MeasurementsWizard

Templates — panel for definition and administration of camera
image templates

Requires user permission group TemplatesWizard
Exposure — This is a group prepared for controls related to exposures.

Designs — panel for viewing and management of designs available on
the defined data sources

Requires user permission group DesignsWizard

Memo - Opens a simple editor to make and save notes.
Requires user permission group MemoWizard

Scripts — Opens a panel for scripts management and programming
Requires user permission group ScriptsWizard

Job — This is one of the central control panels. It contains all necessary
controls for definition and execution of jobs, exposures as well as
measurements.

Requires user permission group ProcessWizard

SystemControl — This is another key control panel, as it gives access to manual control of
several components.

Requires user permission group SystemControlWizard
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Metrology - Cameras

This panel offers control fuctions for everything related to the camera image. While the
general functions are collected in toolstrips, specific controls are sorted in three control
sets: Control, Keys and Calibration.

TOOLSTRIPS

Main see Chapter 1: Startup and General, section General Functions

ImageControl  contains icon buttons for start and stop of image acquisition, as well as a
text control for Snapshots and text controls for camera selection
(MacroCamera, MicroCamera ...)

.

= 'Live', restarts image after it was frozen e.g., for a
measurement or a snapshot

* =i

& 'Snap’, stops image acquisition and holds last image

Snapshot

freezes the image and offers to save it as an image file

MacroCamera | MicroCamera

camera selection controls, the blue frame denotes the
currently active camera

SystemSetUp  contains controls related to the Keys control set

_
[

-

- adds a new system setup key

=

- deletes the currently highlighted system setup key

b \!\; F

- applies the highlighted system setup key
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CONTROL

This control set contains sliders for adjustment of parameters that influence the current
camera image. . Controls at both ends of each slider allow to jump directly to the limit
values. Above each slider, the current value is shown.

Position (-100 — 100) motorized cameras only (configuration dependent). Controls the
position of the camera

Brightness (0 — 100%) regulates the power of the illumination light source.

Offset (-100 - 100) controls the minimum amount of light necessary to create a gray
level for a pixel. This function can reduce the stray light influence,
or elevate the light level from substrates with very low reflectivity
to visibility. Beside the current value, a control allows to reset the
offset to 0.

Exposure Time (0 — 100 seconds) determines the time span of light acquisition for
each image. Should be used if the Brightness range is not
enough to give a satisfactory result.

Gain (0 — 30) increases the contrast by multiplication of each pixel value with a
certain factor. As also the base light level is increased in this way,
usually this has to be used in combination with the Offset
regulation to get a satisfactory contrast

KEYS

The Keys control set serves to manage parameter sets for camera images (keys). They
can be used to save parameter sets that are used often, in case that on the one hand
different kinds of substrates with different reflectivity are used, but on the other hand every
type comes into use often enough to need a fast way of switching to the related camera
settings. These keys can be used wherever measurements are done (alignment scripts,
measurement scripts, and the related panels).

The left part of the keys control set shows a list of existing keys for the currently selected
camera. The parameters contained in the highlighted key are listed in the right half of the
window and can be edited there. These are:

CameraParameterSet same as Exposure Time, Gain and Offset above

FocusOffset offset of the write lens with respect to the default position where
the camera image is sharpest

LampParameterSet = same as Brightness above

PositionOffset offset of the camera position with respect to the default position in
systems with motorized cameras

Controls for adding or deleting complete keys are available in the SystemSetUp tool strip
and explained above.
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CALIBRATION

The Calibration control set is actually only a list of information on calibration data related
to the currently selected camera. The data can only be changed via the related calibration
wizards (Wizards - Calibration), or via the Device panel of that camera (user
permissions required for access).

The parameters on calibration are:

Date Date when the last calibration operation was done

Matrix > Camera2World A matrix representation of the camera calibration parameters
Parameters >

Angle of rotation Rotation of the camera with respect tot the movement axes of
the stage; calculated during camera calibration

Offset X/Y Distance between the image center of this camera and the
image center of the reference camera (usually, top micro
camera)

Scaling X/Y Size of one image pixel on the substrate

BeamOffset Distance of the begin of the writing scan from the center of the
image

Metrology - Measurement Recipes

This control set combines all necessary functions for setup and administration of
automized measurement sequences. Also, single measurement can be done from here.
The setup and test of a measurement sequence is explained in a tutorial section in the
chaper on measurements in User Guide I.

In the standard setup, the MeasurementRecipes control panel contains one specialized
toolstrip, one tree view of available recipes and their sorting folders, and a variable panel
with four different control sets (Grid / Measurement / Evaluation / Test) that contain the
parameters defining a measurement recipe and functions for testing it (only visible if a
recipe is selected). At the top of the control sets partition, the name of the currently
selected recipe is shown in the Editing: line.

TOOLSTRIPS
Main see Chapter 1: Startup and General, section General Functions
Edit contains controls for administration of recipes

_

- w

| - adds a new recipe in the highlighted folder, or the general folder,

if no folder is highlighted. Choose the type of measurement
sequence from the drop-down list (only one type available at the
moment)
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- deletes the currently highlighted recipe

- creates a new folder for sorting of recipes in the highlighted
folder, or the top layer if no folder is highlighted (hit ESC key to
remove all selections)

B

A

4 - creates a copy of the highlighted recipe so it can be modified
e.g., for measurements in the same grid but with a different
measurement method

- deletes the currently highlighted folder. If the folder is not empty,
a warning is issued

GRID

Contains the parameter set for selection of the geometrical arrangement of
measurements. Some functions are available that allow to use a sample plate for easier
setup of the grid.

List:

General > Order Defines the order in which the measurements are done. The
measurement sequence can be executed line-by-line (XY), or
column-by-column (YX)

Starting Point >

Offset  Defines the position of the first measurement point in the grid. This has
to be a corner of the measurement field. Which corner should be
chosen depends only on the selection of the sign in the step definition.
Values can be edited directly in this field, or in the separate fields of
the appended list

Unit Unit for offset coordinates

X/Y Values of offset coordinates, to be entered in the unit
selected above (same unit for both axes)

X/Y-Step > These parameters define how the grid extends from the point defined
before as starting point

Count  Number of measurements per row (x) / column (y)

Step > Distance between measurement points (step width). Values can be
edited directly in this field, or in the separate fields of the appended list

Unit Unit for step width definition
Value  Value of step width in this axis
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Die center coordinate controls:

These controls serve to define the position relative to which the starting point is defined
(coordinate origin for grid positioning). Usually, this is the center of the plate, or the center
of a die within which measurements are to be done.

from stage takes the current stage position as reference position

from camera requests to point to the reference position in the camera image. After
clicking on the button, switch to the camera image and mark the
position as described in the section on the HIVision program (point of
interest). The coordinates of the marked point are transferred to the
list

Zero sets the Die center coordinates back to zero (0/0)

Grid definition controls:

Re Resets the values that are related to the neighbouring control to
minimum

Set starting point Starts a sequence to mark the starting point in the camera image.
After clicking on the button, switch to the camera image and mark the

position as point of interest as described in the section on the HIVision
program. The coordinates of the selected point are transferred to the

list
To Moves to the Offset coordinates in the list
Set x/y-step Starts a measurement sequence to determine the step size directly

from the image of a sample plate. One of the other measurement
points has to be moved into view before the functions is started. After
clicking on the button, switch to the camera image and mark the
measurement point position. When requested for the Index of
position, enter the index number within the row/column. The step size
is calculated from that in the following way: step size = distance from
offset point / (index — 1)

When requested for the Total number of positions, enter the
number of measurements to be done per row/column

MEASUREMENT

This panel contains all controls necessary to define the measurement that should be done
at each of the positions defined in the grid. It contains a drop-down list for selection of the
measurement type, and a parameter list. Which parameters appear in the list depends on
the selected measurement method.

Measurement methods list

SingleEdgeDetectionMeasurement Makes a single measurement detecting the position
of the first edge from left / top within the area of
interest (Aol)
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CenterDetectionMeasurement

TemplatePositionMeasurement

LineWidthMeasurement

LineEdgeDetectionMeasurement

ManualPositionMeasurement

StitchingMeasurement

CrossPositionMeasurement

EdgeRoughnessMeasurement

ManualDistanceMeasurement

Detects the positions of the first and second edge
within the Aol and returns the position between
them, assuming this is the center of a line

Compares the camera image with a pre-defined
template image and looks for the first match from
top left that has a certain minimum degree of
resemblance under coarse resolution. If
comparisons with increasing resolution stay below
the definedlimit, the match is dismissed and an
error returned

Detects the positions of the first and second edge
within the Aol and calculates the distance between
them

Returns the positions of the first and second edge
within the Aol

Activates a point of interest measurement in the
HIVision program, allowing for a manual selection
of a point within the image. The coordinates of that
point are returned as result

A measurement method that combines two
CenterDetectionMeasurements to compare the
distance between two lines on different sides of a
stripe connection that are supposed to be at a
certain distance (x-stitching) / at the same height
(y-stitching)

Measures the positions of the four arms of a cross
at the Aol borders

Measures the position of an edge over a certain
length. From the standard deviation in edge
position, the edge roughness is calculated

Starts a sequence where first a point of interest in
the current image can be selected, next a
movement can be done, and lastly, a second point
of interest has to be marked. The distance between
the two points is returned

28
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Measurement method properties — required parameters

While the checkbox
that always have to

Show only required parameters is selected, only those parameters
be adjusted to a measurement are shown. Advanced parameters that

influence the details of a measurement are hidden and will only show up if the checkbox is

deselected.
Devices >
Camera Selection of camera to be used for the measurement. Available
cameras can be selected from the drop down list
SystemSetupKey

Selection of setup key with camera and illumination parameters to be
used for the measurement. Available parameter sets can be selected
from the drop down list. Nearly all measurement methods listed above
are based on the detection of borders between exposed and
unexposed regions. A setup with good contrast is required so these
borders can be clearly detected

Image processing 2>

AreaOfinterest

Direction
Template

Boxes >
Count

Defines the area within an image inside which the object should be
detected. Detection always starts from left to right, and top to bottom
within the selected area. Therefore, it is important that no other
features are above / left of the feature that should be measured when
the area of interest for the measurement is defined. Select the
parameter and click on the three points at the end of the row to define
the Aol directly in the image. Parameters are shown as set in the main
line, and separately in the sub rows. They can be modified manually in
both places

Height  Height in pixels of the Aol

Width Width in pixels of the Aol

XY Position of the left/upper border of the Aol

Axis direction for the measurement, select from the drop down list

Template file to be used during template detection, select from drop
down list of available files

In edge roughness measurement, number of measurement points
along the edge
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Measurement method properties — extended parameters

Each measurement method contains some additional parameters that influence the way
the measurement is done on a more advanced level.

AOIls - Sub AOI dimension

Size in pixels of the sub Aols created along the line edge within the Aol.
Maximum size is the Aol size in this axis divided by the number of points
(Boxes > Count)

Image processing 2>
Allowed center deviation

Allowed deviation of the found position from the image center to
directly accept the measurement. If the structure is found further
away, the stage is moved to bring it closer to the center, and the
measurement is repeated

DetectionOptions

Per factory default, the size of a line is determined from the inside of
the line. The point where 50% of the difference in intensity is reached
is taken as the edge position. To avoid effects of noise, an
interpolation between several pixels is done. However, this is not
necessarily the correct or the best way of measuring.

Especially for measurements on emulsion, great care has to be taken
when setting up the parameters, as in top lighting emulsion lines tend
to have more opacity in the borders than in the center. Thus, if the
limits are not set properly, the image processing software might
identify one thick line as a pair of thin lines instead. Similar problems
might occur in thick resists, or on substrates with multiple layers.

Interpolation Number of pixels combined for averaging when
calculating the relative signal level. Factory default
setting 5

Model Defines which part of the edge line curve defines the
edge position (boundary Inside / Outside structure).
The structure is defined to be located after the first
edge detected. Factory default setting Inside

Threshold Signal level in % of the full signal difference that
defines the position of an edge. Factory default setting
50

Height [%]
Height of the cross arms detection area in % of the full image
ImageProcessor

If several image processor programs are available, the selection from
the drop down list decides which one to use for the measurement.
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Length [%)]

Length of the cross arms detection area in % of the full image

NominalValue

A value that should be substracted from the measurement values to
directly get the errors or instabilities. Parameters are shown as set in
the main line, and separately in the sub rows. They can be modified
manually in both places

Unit Distance unit
Value Nominal distance in the given unit

Repetitions

StepAway

Determines the number of detection repetitions that are averaged for
the end result

Selects if the stage moves between detection repetitions

StepAwayDelay

Sets a delay between step and new measurement. Parameters are
shown as set in the main line, and separately in the sub rows. They
can be modified manually in both places

Unit Time unit
Value Number of time units the delay should take

StepAwayVector

Threshold

Sets movement vector for step away function. Parameters are shown
as set in the main line, and separately in the sub rows. They can be
modified manually in both places

Unit Distance unit
XY Step distance in the given unit

Detection reliability required to accept a result

Result Accuracy 2>

SignificantDecimals

Unit

Determines with how many valid decimal places the results are
processed

Measuring unit used in the report

Misc > LastDuration (Read only)

Duration of the last measurement done with this measurement
method
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EVALUATION

Summary If summary is enabled, the results that are averaged are listed in a
summary table at the end of the report.

Averaging This drop down list allows to enable or disable a global averaging over

all results of a grid measurement.

Averaging Mode If global averaging is enabled, this second list determines in which way
it is executed:

Values All measurements from all grid points are averaged

MeanValues The mean values from repetitions at one grid point are
used as basis for the averaging

TEST

Functions:
Execute Starts a test measurement run
Stop Stops the test run

+/- Opens/closes the list of parameters that describe the environment for the test
execution. For more information on the parameters in this list see subsection
Properties in the section Job that describes the Job control panel further down
in this chapter

32 User Guide Part Il



HEIDELBERG DWL 66"

iINSTRUMENTS

Metrology - Measurements

The Measurements control panel can be used to make single measurements, or create
predefined parameter sets for measurements. This includes not only the structure
measurement methods known from the Measurement Recipes control panel, but also
algorithms used in global alignment or during calibrations.

In general, this panel is quite complex to use for single measurements. It is therefore
recommended to rather use the Measurement Recipes control panel described above
with just one grid point defined, or to create a toolstrip item from the Measurements set in
the System Control panel.

The two functions of this panel reflect in the two toolstrips: The Store toolstrip is for
maintenance of pre-defined parameter sets for measurements (keys), the Measurement
toolstrip contains the functions necessary for execution of a single measurement.

In the Parameter store section, the keys available for the currently selected measurement
type are visible and can be selected.

TOOLSTRIPS

Store _j_ - creates a new parameter key item for the currently selected
' measurement type. Double click on the key name to rename it

___ - deletes the currently selected key

drop down list for selection of measurement method
for which a key should be defined / edited / deleted

Measurement  NotSet- - drop down list for selection of measurement method for
single measurement. Once a method has been selected,
the name appears in the control

SingleEdgeDetectio -

parameter - Sets the panel to parameter view

Result - shows the result of the last measurement

) - starts measurement execution

e - interrupts measurement execution

Tools ~ - drop down list giving access to options regarding

measurement results

Save report — saves log of the measurement process and
result to the selected folder and file

Save exception — if an exception has occurred, the report
can be saved from here
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Metrology > Templates

This control panel is used to manage existing template files, or create new ones.

TOOLSTRIPS

Main

see Chapter 1: Startup and General, section General Functions

Action contains controls for template management
|
' - creates a new image template. The currently selected template can
be overwritten, or a new name can be entered. Specify the region
within the current image that should be used as template (Aol) and
confirm. The new template is saved and appears in the template
viewing section of the panel
- deletes the currently selected template
U= starts a test where the system tries to detect the selected template
in the current image
FireFips " - active image processor, can be changed by selection
from the drop down list
Select offers functions for browsing of the existing templates. The selected image
template is shown in the viewing section of the panel, the name appears in
the drop down list at the top
I* - jumps to the first template
* - loads the previous template
Temporary 14 - name of the currently selected template. From the drop
down list, any other template can be selected
» - loads the next template
»I - jumps to the last template
34

User Guide Part Il



HEIDELBERG ow. a5

Exposure > Designs

The Designs control panel serves to manage the available designs on the design data
source(s). On the left, a tree view shows the contents of the lic data source. The panel
splits into a left and right part if properties view is selected.

TOOLSTRIP

Main see Chapter 1: Startup and General, section General Functions

DWL66SYSTEMCONTROLLER VIEW PANEL — FUNCTIONS

Several function buttons are available below the directory tree panel:

update updates the directory tree view

HE - adds a new main category folder

=

Ll - adds a new subfolder to the currently selected category folder

- deletes the currently selected (sub)folder. A warning is issued if the folder or a
subfolder in it contains design data

- deletes selected design

Properties splits the panel and shows the properties of the selected design in the right

part
DWL66SYSTEMCONTROLLER VIEW PANEL — PROPERTIES
Misc > PossibleWriteModes
List of available write modes the design was prepared for
General >
Category

Name of the category/categories into which the design is sorted. First
stands the root directory, sub-directories follow divided by points

Name
Design name
Provider
Lic source that provides the design

Data > Contains design information. Parameters are shown as set in the main line, and
separately in the sub rows
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Number of Stripes (not vector mode designs)
Number of stripes into which the design was divided
Path file (vector mode designs only)
Name of the conversion result file defining the exposure paths
Number of Elements (vector mode designs only)
Number of paths contained in the exposure
TypeName

denotes if a design contains data for scanning or vector mode
exposure (BinaryData/GrayScaleData/VectorData)

ScanWidth (not vector mode designs)

Scan width selected during conversion. Can be extended to view
number and unit separately

SizeOf  Shows the design size. Parameters are shown as set in the main line,
and separately in the sub rows

Unit Size unit
XY Sizes in the corresponding axes, in the given unit

Offset Shows where the lower left corner of the design will be positioned
within the die. Parameters are shown as set in the main line, and
separately in the sub rows

Unit Distance unit
XY Coordinate value in the corresponding axis, in the given
unit

FocalLength

Focal length of the write head the design was prepared for.
Parameters are shown as set in the main line, and separately in the
sub rows

Unit Length unit (usually mm)
Value Focal length in the given unit
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Scripts

In this panel, existing scripts for execution before or after a design or a job can be
managed, and new scripts can be created. This can include scripts for alignment or
operations that should regularly be done in combination with exposures, but are not part of
the standard set of options (e.g., laser switch off after exposure). The script language is
C#.

The Script control panel consists of toolstrips, a list of available scripts on the left, an info
window with info on the currently selected script below, and the script editor on the right.
For information on available functions, please consult Heidelberg Instruments.
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Job

The job control panel is one of the central components of the system. It is divided into the
browser section on the left and the editing/execution section on the right. The necessary
general or specific functions are sorted into toolstrips.

The editing/execution section contains two function sets that can be selected by clicking
on the related tab, if the related user permissions are given. The tabs show the name and
some properties of the object that is currently being modified/executed. If in editing mode,
the menu automatically swaps to the execution function set whenever a job is started, and
swaps back afterwards. However, the results of the last job execution can still be viewed in
the execution tab.

TOOLSTRIPS
Main see Chapter 1: Startup and General, section General Functions
Templates gives access to functions related to job templates

Requires user permission group Job.Modify Templates

-
I

1 w

- creates new template item according to the selection from the drop
down list (MeasurementJob / MeasurementJobContainer /
Exposuredob / ExposureJobContainer). Each template item appears
in the related template subfolder.

=

- deletes the currently selected template. Deletion can also be done
using the Delete key, or by right-click on the item and selecting
Delete.

Job contains controls for the execution of exposure and measurement jobs

Execute () - ighli i
HECTE 857 starts execution of the currently highlighted job

Stop e - stops current job execution

Convert i 4 :
- creates a new measurement job from the currently selected
exposure job
Map contains general controls for setup of exposure and measurement jobs

Activat . . L
o VA sets the currently selected die(s) to 'activated', meaning it
will be executed during job execution

Deactivat - i
° cactVEe _ sets the currently selected die(s) to 'deactivated’
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% é - opens a drop down list of all optional columns in the
spreadsheet, sorted into groups. Click on a column name
to change its state between visible and invisible. A tag

indicates that a column is visible.

i - adjusts the size of the map representation to the available
space between the parameter view / the toolbars and the
panel border to make all fields visible with the largest
possible size

e/ TR - clears the design(s) / measurement(s) from the currently
selected die(s)

Tools contains controls for setup of parameter series

Series -
- opens a drop down list that contains parameters for which

an exposure series can be created automatically over the
currently selected dies. Once a parameter has been
selected, a dialog window prompts the operator for start
value and increment

Matrix
- starts a process where two parameters can be selected for

automatic creation of an exposure matrix within the
selected map area. One parameter is varied along the row,
one from row to row, creating all possible combinations of
the parameter values given as range if all selected dies are
connected. If the selected dies do not form a closed area,
parameters still start at the leftmost / topmost die and
change incrementally for each die from there, regardless of
if it is selected or not
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BROWSER SECTION

The explanations given here presume knowledge of the general explanations given in
Chapter 1: Startup and General, section General Functions, subsection Lists.

5 7 Tempiates The browser section contains all available jobs and, if related
5 7] Measuementiob permissions are given (Job.Modify), a separate folder that contains
~Fivetemae 2 all available job templates. Jobs can be stored either directly in the
- [ measuementionconizner - tOP layer, or sorted into job containers, if any were prepared.

o

| NewTemplate_1

Jobs or job templates can either contain exposures or

- [l Ewoeuoios measurements. There is no way to mix these types of action in the
] NewTomelsts same job. In the same way, job containers can only contain jobs of
= single fieldtemp tvpe.

= [77] ExposureJobContainer one typ
-] NewTemplate_3 \

5 B Johns Jobs “. - exposure job icon
e T single field |—:
] Testjobs ~* - measurement job icon

"L testpattern 4mm -

L[ E - exposure job container

=g Maintenance

|... [} Meintenanceoriho E - measurement job container

Pull a template object down into the top level or any of the
matching containers to create a job / job container. Containers may also be placed within
containers.

EDITING/EXECUTION SECTION - EDITING CONTAINERS

Containers have certain properties they can hand down to all items that are sorted into this
container, if these are set to inherit such properties. Other properties are related to the
possibility of executing several jobs together as a batch job.

The properties of a selected container are shown in the Editing function set. They are:
Automation >
AutomationMode

determines menu behavior during loading/unloading. The options that
can be selected from a drop down list are:

¢ Manual - loading and unloading are done fully manually

e SemiAutomatic — both loading and unloading process are
supported by the menu

e AutoUnload - loading is done manually, but the stage
automatically moves to the unload position after exposure

For more detailed information on the loading/unloading process with
each of these options, refer to User Guide I: Chapter 1, section
Loading / Unloading Substrates.
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BeQuiet if set to True, warnings are suppressed. Useful e.g. for tests without
focusing or with laser off.

Count down

allows to set a delay between start of the batch job and start of the
first job e.g., to allow substrates to thermalize. The time can be
entered either directly in the format d.h:m:s, or seperately for each
time unit by opening the parameter subset

ResetCoordinates

if set to True, the coordinate system is reset after the batch job has
been completed

Laser (exposure job containers only) >
FinalMode

detemines setting of the laser power after the end of an exposure job.
The options that can be selected from a drop down list are:

e On - the laser stays at the power last used for exposure

e Off — the laser is switched off

e Idle — the laser goes to a predefined idle laser power
Misc - LastDuration (view only)

shows the duration of the last processing of this job container as a
batch job

Processing 2>
Exception reaction

determines the behavior if an exception occurs during batch job
processing. The options that can be selected from a drop down list
are:

e Proceed — the menu logs the exception, but goes on with the
processing

e Request — a dialog window opens informing about the fact that an
exception has occurred and prompting the operator for the next
action (proceed / stop / skip).

e Stop — the complete job is stopped with an error

e Skip - the rest of the current design/measurement is skipped, an
error is written into the process report. The system resumes
operation with the next design/measurement
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Result 2>
AutoSaveResult

if set to True, batch process results are automatically saved into the
folder given in the parameter ResultFolder. These results only
contain information shown also in the Executing function set after an
exposure, no measurement results

ResultFolder

default storage folder for above option, other folders can be selected
in the job properties

Scripts >
Before / After item

scripts selected here will be executed at the beginning / the end of the
batch job

Exception reaction

determines the behavior if an exception occurs during batch job script
execution. The same options are available as for Processing >
Exception reaction.

EDITING/EXECUTION SECTION - EDITING JOBS / JOB TEMPLATES

In principle, the Editing function set looks identical for jobs and templates. Therefore, if a
template is edited, the background of the map turns to a different color (factory setting:
coral), to warn the user that a template is being altered.

The set is divided into two sections, on the left a spreadsheet with the data for each field,
and on the right a graphical representation of the map. Below the spreadsheet, additional
parameter lists can be opened with the controls Properties, Selection and Designs /
Measurements. The behavior of these sheets depends on several factors:

e if opened by just moving the pointer over the control, they close again immediately
when the pointer leaves the region of the list

e if opened by a click on the control, a click outside the list is required to close it

e if pinned down with the red pin in the upper right corner of the list, the list turns into a
fixed part of the Job panel and all other components are automatically arranged above
it. In this state, the list only closes again after the pin is released and a click outside the
area has happened

£3 panel pinned down

£ panel released
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Job Spreadsheet

The Job Spreadsheet contains one line for each field that was defined in the map setup
(see Properties). Directly selected lines appear blue, lines selected via click in the map
turn gray. Several successive lines can be selected by dragging the mouse pointer over
them with the left button held down, or by selecting the first line and then holding down the
shift key while selecting the last one. Several non-consecutive lines can be selected by
holding down the strg key while selecting them one after the other. Lines selected in the
spreadsheet also appear as selected in the map.

A right click on the map opens a context menu for operations that can be done on all
selected lines at once:

e Context menu
Activate / Deactivate
0 / 9 Another way of changing the setting between activated for processing, or

deactivated
Copy Copies the contents of the currently selected line(s) into the clipboard
Paste Pastes the contents of the clipboard into the selected line(s). If several

lines were copied and just one line is selected, the lines below the
selected lines will be overwritten as well

Clear » Clears the contents of the selected column in the marked lines

Fill down » Copies in the selected column the contents of the first cell down into the
corresponding cells of all other marked lines

Displayed units Copies the contents of the currently selected line(s) into the clipboard

Which columns are available in a spreadsheet depends on the type of job
(exposure/measurement). The first four/two columns of the spreadsheet are standard
columns that are always visible whenever a new job is created. Others can be added via
the related toolbar function (Map - Columns), so additional options can be viewed and
set. A double click on a spreadsheet cell opens it for direct editing or for selection of an
item, or opens an information field showing the full contents.

¢ Standard columns:

Die index Active / inactive icon that shows if a field is set to be processed or not, and
index of the related map field (die). A double field on the icon changes the
active/inactive setting.

Designs / Measurements
Design to be exposed / measurement to be executed in this field of the
map. Contents can only be altered via the Selection section, or via drag-
and-drop of designs / measurements into the selected spreadsheet field(s)
or the corresponding map field(s)
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Intensity [%] (exposure only)

Light intensity to be used for the exposure. The necessary intensity
depends on the write mode as well as thickness and sensitivity of the
photoreactive layer and has to be found out by exposure series with
varying intensity. Contents can be altered directly or in the Selection
section

Focus [%] (exposure only)

Lens position offset with respect to the default focus position that should
be used for the exposure. Which is the best focus position depends on
resist thickness. Also, over longer times, drifts can lead to a change of the
best focus position. Therefore, the focus has to be checked regularly in
exposure series with varying focus. Contents can be altered directly or in
the Selection section

e Optional columns:

Common >

Before die script

Activates a column where scripts can be selected that are executed before
an exposure or measurement (e.g., a field alignment). Contents can be
altered directly or in the Selection section

After die script

Activates a column where scripts can be selected that are executed after
an exposure or measurement (e.g., a script to switch off the laser).
Contents can be altered directly or in the Selection section

XY Offset (exposure only)

Shows the design offset in um in the format (x/y). By default, the design
origin is positioned at the center of the field. By entering an offset, the
design can be shifted in X and Y direction. Positive numbers shift it to the
right / up, negative numbers to the left / down. Keep in mind the
orientation of the coordinate system. Contents can be altered directly or in
the Selection section. Direct editing has to be done in the format x/y

Pen (exposure only)

If the field contains a vector mode design and the system has different pen
configurations available in the current write mode, selection of the pen
from a drop down list can be done here or in the Selection section

0S9 Command (exposure only)

NOTICE: For maintenance only!

Direct commands to the OS9 system controller can be entered here. This
feature is only for maintenance and may only be used by experienced
service personnel, as these commands can affect the system performance
and even lead to damages.
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Expodie >

WriteHead >

AOD >

Expodie: AOD_Position (exposure only)

The AOD position determines the quality of the stripe connection
(stitching) in y. If patterns show shifts in y at the connections, the AOD
stepper position has to be adjusted to a new value. This value has then to
be entered in all future exposure jobs

Z-Position (exposure only)

NOTICE: For maintenance only!

This parameter directly sets the write head position, disregarding the
autofocus regulation. It can cause damage to the system, or lead to
defocussed exposures.

Movement range is software limited to +/- 40 steps for safety reasons.
However, damages are still possible depending on specific conditions.

ConstantCoefficient (fT0) (exposure only)

NOTICE: For maintenance only!

This parameter determines the start of the scan. Changing it will render
the intensity correction invalid.

LinearCoefficient (dfT) (exposure only)

This parameter controls the scan width. If stripes don't connect properly
horizontally (gaps or overlap), this parameter has to be adjusted. An
increase closes gaps, a decrease removes overlap.

all other: (exposure only)

i ]
NOTICE: For maintenance only!

With the other AOD related parameters, the structure positioning within a
scan can be influenced, which can lead to distorted exposures if not done

properly.

Laserpower > Laserpower (exposure only)

Usually, this parameter does not have to be adjusted, as the control of the
power on the substrate is done via the Intensity parameter, with the laser
set at a value optimized for stability and longevity. However, under special
conditions, it might be necessary to adjust the power e.g., for gray value
exposures with low power, where the intensity correction might get too
coarse if the power is set with the Intensity parameter. Depending on
laser type and write mode, the laser power may be not adjustable. In this
case, the column entry is ignored.

Reference Manual 45



HEIDELBERG DWL 66*

iINSTRUMENTS

Map

The map section shows a graphical represention of the map layout defined in the
Properties section. The background color shows if the map belongs to a normal job
(standard background) or to a job template (user defined color, factory setting: coral). The
background color setting for templates can be adjusted in the Show options list that can
be opened from the Main toolbar (Process item editor > TemplateColor). The color can
be edited in RGB format, or selected from three different palettes (Custom, Web, System)
that are accessible via drop-down list.

Some graphical features give information about map and field parameters:

- The upper left edge shows by icon and color if the field is activated for
processing (green, tag) or not (red, cross). A double click on the icon
changes the state.

- The color of a field shows if it has been selected (dark) or not (light).
Selection can be done in the spreadsheet or the map. Selection of a
region of fields in the map can be done by dragging the mouse pointer
over them with left button pressed, or by clicking on one of the corner
fields and then holding down the shift key while clicking on the opposite
corner. Selection of several fields that are not connected can be done by
holding down the ctr1 key while clicking on them.

f - A cross in light gray shows the location of the map origin as selected in
ar the Properties section. It can be in the center of a field or on any of the
edges or corners (see below).

| / L—j - to the right of the active/deactivated icon, an icon shows information about
Ll the field contents. A filled vector structure stands for a design (exposure
job), a stylized oscilloscope for a measurement.

° ‘.. -the same icon also shows if the field contains just one
. design/measurement, or several (example for designs).

Note: Icons are only visible if the map field is large enough.

Like the spreadsheet, the map offers a context menu that allows to make operations on
selected fields. The context menu is in general identical to that of the spreadsheet, but
there is one item:

Show list entry Moves the spreadsheet so that the line related to the map field on which
the context menu was called is visible
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Properties

This parameter set is related to the selected item (exposure job / measurement job) as a
whole. Most of the listed parameters are identical to the ones for containers. In such
cases, an additional option inherited is available, which means that the container setting is

used.
Automation >

AutomationMode

BeQuiet

Count down

determines menu behavior during loading/unloading. The options that
can be selected from a drop down list are:

Manual — loading and unloading are done fully manually

SemiAutomatic — both loading and unloading process are
supported by the menu

AutoUnload - loading is done manually, but the stage
automatically moves to the unload position after exposure

Inherited (...) — uses the selection of the container (current
selection shown in brackets)

For more detailed information on the loading/unloading process with
each of these options, refer to User Guide I: Chapter 1, section
Loading / Unloading Substrates.

if set to True, warnings are suppressed. Useful e.g. for tests without
focusing or with laser off.

allows to set a delay between start of the job and start of the exposure
e.g., to allow a substrate to thermalize on the stage. The time can be
entered either directly in the format d.h:m:s, or seperately for each
time unit by opening the parameter subset

ResetCoordinates

if set to True, the coordinate system is reset after the job has been
completed

Misc - LastDuration (view only)

shows the duration of the last processing of this job
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Dimension 2>
Column count
number of columns in the job layout
Row count
number of rows in the job layout
Size of die
size of each field in the job layout

Exposure / Measurement 2>
Exception reaction

determines the behavior if an exception occurs during job processing.
The options that can be selected from a drop down list are:

e Proceed — the menu logs the exception, but goes on with the

processing

e Request — a dialog window opens informing about the fact that an
exception has occurred and prompting the operator for the next

action (proceed / stop / skip).

e Stop — the complete job is stopped with an error

e Skip - the rest of the current design/measurement is skipped, an
error is written into the process report. The system resumes

operation with the next design/measurement
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Field Zero >

Indices sets the location of the origin within the job layout by denoting column
(X=) and row (Y=) of the field in which it should be located.
Parameters are shown as set in the main line, and separately in the
sub rows. They can be modified manually in both places

X column index of the field containing the origin
Y row index of the field containing the origin

Location determines where within the field the origin is located. The options
that can be selected from a drop down list are:

e top left e top center e top right

e center left e center e center right

e bottom left e bottom center ¢ bottom right

-
X

Focussing (exposure jobs only) >

Mode offers a drop down list with focusing modes available on the system
for selection
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Laser (exposure jobs only) >
FinalMode

detemines setting of the laser power after the end of an exposure job.
The options that can be selected from a drop down list are:

e On - the laser stays at the power last used for exposure

e Off — the laser is switched off

e Idle — the laser goes to a predefined idle laser power

Report (measurement jobs only) >

ReportFolder

folder into which the measurement results should be stored
ReportName

mask for naming of reports. Available components are

e <Name> — job name

e <Date> — date of process execution

e <Time> — finish time of process execution

These components can be arranged in any order, and any other
characters may be used in between, within the limits set by the
operating system

ViewReport

if set to True, the measurement report is opened for viewing after
process execution

Result >
AutoSaveResult

if set to True, process results are automatically saved into the folder
given in the parameter ResultFolder. These results only contain
information shown also in the Executing function set after an
exposure, no measurement results.

If set to Inherited (...), the selection of the container is used (current
selection shown in brackets)

ResultFolder
storage folder for above option.
Scripts >
Before / After every die

scripts selected here will be executed at the beginning / the end of
every die within the job

Before / After item
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scripts selected here will be executed at the beginning / the end of the
job
Exception reaction

determines the behavior if an exception occurs during script
processing. The same options are available as for Processing >
Exception reaction.

Selection

This list has several sections. On the left, it shows the properties of the selected dies in a
table. If several dies have been selected, only property values that are identical are shown.
All other value fields are left blank.

The right half is dedicated to displaying information about the design(s) used in the die(s).
Die properties are:
Design >

Offset shows the design offset in um in the format (x/y). By default, the
design origin is positioned at the center of the field. By entering an
offset, the design can be shifted in X and Y direction. Positive
numbers shift it to the right / up, negative numbers to the left / down.
Keep in mind the orientation of the coordinate system. Can also be
altered directly in the spreadsheet if the column has been set to
visible.

Parameters are shown as set in the main line, and separately in the
sub rows. They can be modified manually in both places

X/Y offset values in the given units

Unit length unit used for the offset. Has no effect on the
representation in the spreadsheet. Units in the spreadsheet
have to be altered via the context menu

Focussing 2>

Offset lens position offset with respect to the default focus position that
should be used for the exposure. Which is the best focus position
depends on resist thickness. Also, over longer times, drifts can lead to
a change of the best focus position. Therefore, the focus has to be
checked regularly in exposure series with varying focus. Can also be
altered directly in the spreadsheet

General >
Count down

allows to set a delay before processing of the selection starts. The
time can be entered either directly in the format d.h:m:s, or seperately
for each time unit by opening the parameter subset

Activated if set to True, the die will be processed during execution. Can also be
set in the spreadsheet (die index column) or the map
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Laser 2>

Intensity light intensity to be used for the exposure. The necessary intensity
depends on the write mode as well as thickness and sensitivity of the
photoreactive layer and has to be found out by exposure series with
varying intensity. Can also be altered directly in the spread sheet

Power Usually, this parameter does not have to be adjusted, as the control of
the power on the substrate is done via the Intensity parameter, with
the laser set at a value optimized for stability and longevity. However,
under special conditions, it might be necessary to adjust the power
e.g., for gray value exposures with low power, where the intensity
correction might get too coarse if the power is set with the Intensity
parameter. Can also be altered directly in the spread sheet if the
column has been set to visible.

Parameters are shown as set in the main line, and separately in the
sub rows. They can be modified manually in both places

Power laser power in the given unit

Unit unit used for laser power in the Selection sheet. Has no
effect on the representation in the spreadsheet. Units in the
spreadsheet have to be altered via the context menu

If no value is set, the default value defined in the laser setup is used.
Misc > LastDuration (view only)
shows the duration of the last processing of the selection
Scripts >
Before / After die

Scripts selected here will be executed at the beginning / the end of
every die in the selection.

Before / AfterEveryDieScript

This field serves to show scripts that were already defined in the
Properties section for all dies of the map.

The design information section consists of a list of all designs used in the active selection
on the left, and a text box for data lists on the right. In addition, there are some controls for
modifications of view and design parameters:

Remove — updates the directory tree view

Apply for all — copies the design to all selected fields

Clear — clears the design list, deleting all design entries of the selection

Design — changes the data in the text box to the parameters decided during

conversion (read only)

Parameters — changes the data in the text box to the parameters decided by menu
settings
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The menu editable parameter list shows the following parameters:
Misc > DebugFlag

sets the level of system side debugging during exposure of the
selected design if menu is in debug mode:

$0800 program variables
$0400 Parser

$0100 Messages
$0004 calculated values

If not told another value by a Heidelberg Instruments engineer, use
$900 for collection of debug information.

Exposure count

number of times each exposure of the design within the selection is
repeated

Focus mode

offers a choice between available focus modes, or to inherit this
choice from the map properties (Inherited, default setting). Available
choices depend on system hardware configuration

Write mode

offers a choice between available write modes, considering the way
conversion was done (vector mode conversion - only vector mode
write modes allowed etc.)
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Designs

This parameter set shows the available designs and contains tools to manage them or get
more information about a design. From here, designs can be added to the job by drag-
and-drop into a spread sheet line or a map field. If a selection is active in the
spreadsheet/map and the design is dragged into any field fo this selection, it is added to all
fields of the selection.

Note: This panel can also be accessed separately via Controls > Exposures - Designs.
The design list is a standard folder list. The available controls are:

update — re-reads the list of available designs from the design source
~ adds a new folder in the top layer. User is prompted for a folder name
|':$3_ - adds a new subfolder in the currently selected folder. User is prompted
Cras for a folder name
I,j — deletes the currently selected folder
© deletes the currently selected design
Properties - opens/closes the Properties section in the right part of the Designs

parameter set, where properties of a currently selected design are shown
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System Control

The system control panel is the central control panel for direct hardware control on an
operator level. It is useful for the more advanced operator to have more flexibility in job
execution, or for tool debugging.

The panel is divided into a functions section on the left, where predefined function sets can
be shown or hidden, and a parameter section on the right. The number and contents of the
toolstrips available in this panel are very flexible. A wide selection of possible toolstrip
parameters is offered in the Show options toolset. Therefore, available toolbar functions
are described in their context here instead of the location. Also, the handling of the
toolstrip adjustment section of the Show options toolset is described.

STAGE FUNCTION SET 8|
Movement 100000 [ 0gumy
controls 200{pm)
The machine can be damaged - D Step size!
irreversibly if stage movement leads to a ‘ controls.,
crash of the write head nozzle against | 100
the substrate or another obstacle.

Therefore, the controls have to be used | 'Step:size control status line
with caution, and it has to be made sure |iOrgin. | cenien  Lom
that no such collisions can happen.

¢ |[f a substrate should be measured, make sure that its surface is not tilted

e Make sure focusing was done well on the substrate, not close to the edge
or beside the substrate

This set of functions also appears partly or fully in several other panels and wizards. It
contains all necessary controls for manual stage movement:

Step size controls — These controls determine the step sizes for movement with the
movement controls.

With the slider, adjustment of the step size to arbitrary values is
possible. The currently selected value is visibe in the status line.

The buttons set the step size to the discreet value given on it. The
slider is adjusted automatically.

The list arrow to the left of the center button between the arrows
opens a panel that allows to change the step values on the buttons.

Movement controls —These controls immediately start stage movements.

With the four arrow buttons, stepwise movements by the pre-
selected increments are done. Each click starts a movement in the
direction indicated by the arrow by one step.

The button in the center activates a Point of Interest
measurement in the HIVision program. The point selected here is
then moved to the center of the image field.
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With the Load button, a loading / unloading movement sequence is
started. The write head moves up, and the stage moves to the pre-
defined Load position. This movement is done in the interferometer
coordinate system. The choice of origin in the job coordinate
system has no influence.

The Center button moves the center of the movement range below
the write head.

Origin control — The Set zero control resets the job coordinate system to 0,0 in the
current position.

/G- collapses / expands the Stage function set

WRITEHEAD FUNCTION SET - .
2 % [o]
_—

This function set gives manual control over the

position of the write lens.
This slider allows to fine adjust the position of the lens after focusing, to optimize
the camera image or adjust the position of the focal point to compensate e.g., for
resist thickness. The current value is shown above the slider. Controls at both
ends of the slider allow to jump directly to the limit values. A control to the right
of the status text allows to reset the slider to 0.

D '

Focus-Offset —

i — Focus; moves down the write head until the standard focus position has been
reached

T — Standby; moves the write head up into a standby position without resetting the
counter

-]/ &) - collapses / expands the Writehead function set

SHOW OPTIONS

= The Show options function is part of the Main toolstrip of every panel. A click on it
= opens the Edit wizard settings panel. This panel consists of two parts, the list of
general options on the left, and the Toolstrip manager on the right.

« — Saves the settings and closes the panel

— Closes the panel without saving

The available general options depend strongly on the panel. It can be color settings, units
for movement or measurement, or the list may even be empty.

The toolstrip manager consists of two segments, the two top toolstrips and a section
showing the current status of the edited toolstrip.

Toolstrips
_|_ — creates a new toolstrip
|

___ — deletes the currently selected toolstrip
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<selected item> — opens a drop-down list of the currently available

Items Commands

toolstrips. The selected toolstrip can then be edited
with the tools in the ltems toolstrip. The control shows
the name of the currently selected toolstrip

— Opens a drop-down list that contains all commands
available as toolstrip items

Measurement — Opens a drop-down list that contains all measurement

Script

Separator

—]

algorithms available as toolstrip items. For descriptions of
the measurement methods, refer to the section on
measurement recipes in Chapter 3: Controls

— Opens an editor that allows to create a toolstrip item
linked to a script

— Adds a separator behind the last item in the toolstrip
— deletes the currently selected item

TOOLSTRIP ITEMS - COMMANDS

This is a list of available toolstrip functions as they are sorted in the Show options toolset.
The real sorting into toolstrips that is found in the System control panel might be
completely different. Availability of some controls depends on system configuration.

Interferometer Reset -
Update —
Selected write head

T T
I I I

|
I

» |@

resets the interferometer
re-reads the current position

Initialize; moves the write head into the upper end position
and resets the counter

Freeze; keeps the write head lens in the current position,
disabling the autofocus regulation

Fix; fixes the write head lens in a position, disabling the
autofocus regulation. Fix position is determined by the entry
in the text box that is accessed by clicking on the arrow

Enable; re-activates the autofocus regulation after Fix or
Freeze has been used

Focus; moves down the write head until the standard focus
position has been reached

Standby; moves the write head up into a standby position
without resetting the counter
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Shutter, Laser

A CAUTION!

[\

Stage (Coordinates)

Eye damage!
The DWL 66" uses a laser of either laser class 4 or 3B
(according to DIN EN 60825:1) that is under misuse
potentially harmful to the eye.

e Don’t stare into the beam

e Don't put anything reflective into the beam path

— opens the laser shutter, allowing the beam to travel through
the optical setup
— closes the laser shutter, blocking the beam

— switches the laser on

— switches the laser off

Reset coordinates —

b

L4

o

iy

PSS

resets the job coordinate system to the interferometer
coordinate system (raw coordinate system)

— Initialize; moves to the home position and resets the
interferometer coordinate system

— Shift position; moves the origin of the job coordinate
system by the distances given in the following dialog
window

— Set position; a dialog window opens requesting the
coordinates that should be assigned to the current position
in the job coordinate system

— Set 0,0; sets the current position as origin for the job
coordinate system

— Rotate coordinates relatively; rotates the job coordinate
system by a given increment.

— Set absolute coordinate rotation; rotates the job
coordinate system to the given angle relative to the
interferometer coordinate system
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Stage (Movement and Positions)

NOTICE: The machine can be damaged irreversibly if the stage is moved using

one of the controls listed here while the write head is not in retracted
position.

Always move the write head into Standby position before starting a
movement with these controls, or make sure it cannot hit any object
loaded on the stage.

=+ — Move; the stage moves by the increments given in the
following dialog window. Direction is decided by signs.

i b — Move to coordinates; the stage moves to the job
+ coordinates given in the dialog window that follows

Raw move to —

The stage moves to the interferometer (raw) coordinates
given in the dialog window that follows

Edit positions; opens a panel where coordinate sets can

EL be stored under a name describing the position

MoveTo - — Move to position; opens a drop down list of positions
that were defined using the Edit positions function. A
click on one of the positions starts a stage movement
towards that position.

Axes ~ — Axes control; gives direct control over the motors. The
motors can be disabled or enabled axis-wise, or
simultaneously with the commands in the drop-down list

LithographySystem — Camera Tools

Eﬂ — Center camera position; moves a Point of Interest
selected in the camera image to the center of the image

LithographySystem — Positions
NOTICE: The machine can be damaged irreversibly if stage movement leads to

a crash of the write head nozzle against the substrate or another
obstacle.

Therefore, the controls have to be used with caution, and it has to be
made sure that no such collisions can happen.

e |f a substrate should be measured, make sure that its surface is
not tilted

e Make sure focusing was done well on the substrate, not close to
the edge or beside the substrate
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The positions cited here have factory default settings matching the names. However, these
can be edited with the Edit positions function (item list Stage - Edit...) .

Load
Unload

Center
Exchange

moves the stage to the Load position

moves the stage to the Unload position (usually identical
with Load)

moves the stage Center below the write head
moves the stage to the position for writehead Exchange
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Chapter 4: Wizardry

The wizards are the most basic tools of the Lithography Menu. They lead through
standard procedures, using standard parameters in many steps. The wizards are sorted
into thematic submenus:

Writehead
L Calibrate beam offset

Leads through the steps of a beam offset measurement on a two layer overlay
exposure. Required for overlay exposure calibration.

Requires user permission group Wizard.Access.BeamOffsetCalibrationWizard or
Controls.Access.AllWizards

Camera
L Calibrate camera offset

Opens a wizard for measurement of the distances between the cameras of the
systems by measurement of a reference structure

Requires user permission group Wizard.Access.CameraOffsetcalibrationWizard or
Controls.Access.AllWizards

L Calibrate BSA camera offset

Opens a wizard for measurement of the distances between the cameras of the
systems according to exposures

Requires user permission group
Wizard.Access.BacksideCameraOffsetCalibrationWizard or
Controls.Access.AllWizards

L Calibrate camera

Leads through a measurement that returns the distances in X and Y on a substrate
that correspond to one pixel step in the camera.

Requires user permission group WizardAccess.CameraCalibrationWizard or
Controls.Access.AllWizards

Alignment
L Global alignment

Leads through the steps of a two point alignment that allows to calculate the angle of
a substrate, and rotate the user coordinate system accordingly.

Requires user permission group Control.Access.GlobalAlignmentWizard or
Controls.Access.AllWizards

Reference Manual 61



HEIDELBERG o a5

L Create alignment script

Serves to set up a custom alignment script. Scripts can be defined either for global
alignment at the very beginning of a job, or for field alignment to separate dies.
Several field alignments can be used in the same job.

Requires user permission group Wizard.Access.AlignmentScriptCreationWizard or
Controls.Access.AllWizards

Job management
L Create/execute exposure job

Requests all information required for exposure of a single design in the center of a
substrate.

Requires user permission group Control.Access.ExposureltemWizard or
Control.Access.AllSequentialWizards

The wizards are explained to their full extend in the related step-by-step instructions in
User Guide I: System Operation.

62 User Guide Part Il



HEIDELBERG ow. a5

Chapter 5: Tools

The Tools menu comprises mainly of functions and panels that influence the setup and
usage of the menu.

Floating Container —

This control governs the visibility of the Floating Container for external
placement of panels

Change Password —

A function that allows a user to change his own password. Follow the
instructions given in the dialog window

User manager — Control panel for setup and administration of menu users. See the
section User Permissions Management in Chapter 1: Startup and
General for more information.

Requires user permission group Database.Administration

Log Service—  Opens a sub menu for logging control

Start - starts debug logging according to the settings done
in the panels of the Devices menu

Stop - stops logging

Compress — compresses the log files ...

DebugLevel — if higher debug levels have been set via panels of the
Devices section, they can be reset to standard level
here ...

LiveWindow — re-opens the LiveWindow showing online debugging

information if it was closed before
Requires user permission group Menu.AccessLogService
FireFips — Gives access to options regarding control of the HIVision program

Start — restarts the HIVision program if it was accidentally
stopped, or crashed

Stop — stops the HIVision program. Might be necessary for
debugging or troubleshooting

Edit configuration —

shows the HIVision program configuration. See
below for more details
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Configuration —

Show communication —

shows the communiation between menu and
HIVision program. Might be necessary for debugging
or troubleshooting

Requires user permission group Menu.AccessFireFips
Gives access to several system configuration tools and options
Create summary —

puts together the system configuration data to save it
into an xml file. This file can be helpful for system
analysis and trouble shooting

Requires user permission group Menu.AccessConfiguration
Edit menu configuration —

opens the configuration panel for all menu settings.
Further description below

Requires user permission group Menu.AccessConfiguration
Set as default -

saves the current setup as default for the selected
user group

Requires user permission group Menu.AccessConfiguration
Reset to default —

reloads the last setup that was defined as default for
that group for the specific user selected

Requires user permission group Menu.AccessConfiguration

Transfer — transfers the setup for the current user to a different
user, excluding any settings that collide with the
permissions given

Requires user permission group Menu.AccessConfiguration
SaveAll - saves all current settings, defined modes etc.
Requires user permission group Menu.AccessConfiguration

DebuglLevelEditor —

Opens an editor where debug levels can be selected separately for the
system components to generate debug logs for trouble shooting
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FireFips Configuration

File system
L CommandDefinitionFile

name of the file that defines the command set available to the menu for
communication with HIVision

& FilenameOfExecutable
name and location of the HIVision executable file
L TemplateDirectory
directory used by HIVision for temporary storage of templates
L WorkingDirectory
working directory of the HIVision program
GUI Bounds (read only)
L Contains all parameters on size and position
L GUI_Status
denotes the status of the HIVision GUI (0 — not started, 1 — running)
TCP/IP
L IPAddress
IP address of the HIVision server
L Port
communication port for communication of the menu with the HIVision server
L Timeout
Timeout for wait for replies after sending comments
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Menu configuration

EDIT MENU CONFIGURATION PANEL
Logging
- CommonLogPath
Path where log files are saved
L LimitLiveWindowLines

Enables (True) or disables (False) a limitation of the number of lines available in the
Live Window

L MaximalLiveWindowLines
Number of lines to which the Live Window is limited if the related option is activated
L ShowLiveWindowAtStartup

Determines if the Live Window is started during menu startup. If set to 'False’, the
Live Window can still be started from Tools - LogService - LifeWindow -> Start

SystemConfiguration
& HIMT_PG

Opens the Edit system menu configuration panel (see below)

EDIT SYSTEM MENU CONFIGURATION PANEL
Logging
Name and path of the currently used log
UserConfigurations
Here, the default units used in the menu can be set for each user
Warnings

Warnings for optional parameters at job start can be activated (true) or deactivated
(false) for each optional parameter available
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DebugLevelEditor

In this editor, all devices are listed with their available debug levels in a drop down list.
Open the drop down list beside the device that should be debugged and select the
required debug level.

« — Saves the settings and closes the panel

"

— Closes the panel without saving

Standard —
resets all devices to standard debug level

Detailed —
sets all devices to detailed debug level
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Chapter 6: Devices

Which devices are listed in this menu depends on the system configuration. The only
common device panel, the Cameras panel, is fully described in the related sections of
User Guide I: System Operation.

For each hardware component or component group, a separate panel is available to adjust
settings or parameters or do trouble shooting. While each panel has some features related
to the specific component, some controls are similar for all.

Common Toolbars

PROPERTIES
This toolbar is part of any device panel.
] :

—* Update View. Allows to update the shown parameters.

— Setup view. In some device panels, a selection is possible between the display
of common and specific controls. Availability of such a control set can be seen
from the small arrow at the side of the icon. If Specific is selected, only this
control set is displayed in the standard view. If it is deselected, only the common
control set is displayed, regardless of the arrangement of control sets selected.
Requires user permission group Device.AccessSpecificArea
b
- Split view splits the data part of the device panel into sections with one

panel in each.
E’ Tabbed view puts every panel into a separate tab

n Activate / deactivate dummy mode. If dummy mode is active, a blue frame
appears around the icon
Requires user permission group Device.AccessDummyMode

F S

Edit device configuration. Opens the device configuration panel for editing.
Contents of the panel depend on the device

Requires user permission group Device.AccessConfiguration

i Initialize device. Confirm to start an initialization sequence. No communication

with the device is possible during initialization
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Requires user permission group Device.Initialize

o Show device information. Opens a table with some general device information

FAAY Show last initialization exception. Only visible if an exception has occurred.

Opens the exception information window for the last exception that occurred
during initialization of this device.

LOG

This toolbar appears in panels of devices that are not directly controlled by User PC, but
require communication of the menu with either another controller, or the component itself.

Requires user permission group Device.AccessLog

[l _.-"'f

L Opens / closes the communication log panel. A blue frame around the icon
appears if the log is open, and the next control gets active

Al .

—_—— Log panel button with function selection between Save and Clear. Save saves

the current log contents to a file (select path and name in the dialog), while Clear
deletes all current entries. Select one to give the button the related function

CONNECT

Like the Log toolbar, this toolbar appears in panels of devices that are not directly
controlled by User PC, but require communication of the menu with either another
controller, or the component itself. This communication requires ports that can be activated
or deactivated, which might include login/logout procedures.

(=
- Connect to controller / device

S . .
&= Disconnect from controller / device

Reference Manual 69



HEIDELBERG DWL 66*

iINSTRUMENTS

Communication log section

Apart from the cited common toolbars, the device panel usually contains specific toolbars
with contents depending on the device. Also, the contents of the standard main section are
device dependent, it might contain parameter sets, additional control functions or a log.
However, the communication log section that opens when activated from the
communication toolbar has a common setup.

TABS

A register card appears for every communication channel relevant for the device. This can
e.g. be the communication with the OS9 system controller, or with the board itself. The tab
shows which communication channel a register card monitors.

FUNCTIONS

Several functions for content control are contained in each register card. These are:

Save button Saves the current contents of the log section in the currently active
register card into a log file

Clear button Clears the log section of the currently active register card

Autoscroll checkbox If activated, the log text scrolls so that the last line always stays
visible. Otherwise, the scroll slides have to be used to reach the
end of the log.

Save Clear | ¥ Autoscroll
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Appendix A: Glossary

Job coordinate system

(also: user coordinate system)

This term denotes a temporary coordinate system that can be adjusted to the
requirements of each job. After stage initialization, the origin of the job
coordinate system is located in the center of the stage, and rotation with respect
to the interferometer coordinate system (see below) is zero. Via manual choices
or alignment sequences, the job coordinate system can be e.g., adjusted to the
center of the substrate, or optical alignment marks.

Interferometer coordinate system

Die

Overlay

(also: raw or absolute coordinate system)

This is the basic coordinate system based on the optical setup of the
interferometer system that measures the stage position. The origin for each axis
is located at the related interferometer receiver beam in/output window.

(also: field)

Originally, the term die or dice comes from the cutting of a wafer (dicing) into
small units, each of which is the basis of a chip. In the present documentation,
the term is used synonymously for the area on a wafer or plate that is covered
by just one design. This corresponds to one field of the map grid defined to
divide up the available area into sections that contain one design.

In the present documentation, the term Overlay denotes the exposure of several
design layers on top of each other with an optical measurement in between to
determine the current position of the previous layer(s). The precision of a
second exposure that is done directly after the first one without such a
measurement is referred to by the term Registration.

Gray scale exposure

The gray scale exposure mode is an option that allows 3D structuring of resists
to form e.g., molds for micro-optical components, in a single exposure. In this
mode, 100% corresponds to an energy that exposes the resist just down to the
required depth. 126 equidistant energy values are defined in between 100% and
0, each of which reaches less deep into the resist.

The resulting depth of each step within the resist depends on the resist
response. Therefore, for 3D structuring, resists with linear response are most
useful. No undercuts are possible with this method.
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Gray scale exposure settings are determined during design conversion. Refer to
the Conversion Software Manual for more information. Only designs defined in
DXF, STL, BMP or X,)Y,Z-ASCIl format can be converted. For exposure of
designs converted for gray scale mode, the correct write mode is selected
automatically.

Vector mode

With vector write mode, designs that consist only of a few narrow lines but cover
a large area (like e.g., waveguides or micro-fluidic channels) can be exposed in
a more effective way. In standard write mode, the whole area within which
structures exist is scanned, and the laser beam is turned off and on with the
required energy wherever there is a design part. In this way, lines are created by
many exposure flashes.

In vector mode, a line is written in one stroke, where the laser beam is switched
on at the beginning, and off at the end of the line, and the stage moves in
between according to the line direction(s). This improves line quality a bit, but
mainly, it can save time if in the usual way a lot of empty areas would have to be
scanned. Vector mode can only be used for designs created in Gerber format.
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Appendix B: Revision History

This section contains additions, changes and bug fixes issued after the version this
manual is based on.

Version | Build Affected Menu Change
Section

1.2 5130.25280 | - -
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Notes
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